
Excel Virtually Global is coming!! One of the oldest, longest and best attended Excel events 
returns this October with the usual array of enthusiastic presenters in all things Excel, Power BI and pretty much everything else (well, not quite… - 
Ed.).  We hope to see you there.  You can learn more about this year’s event in our lead article.

We also congratulate one of our key staff, Kathryn Newitt, who hits a major landmark this month, hitting 400 with few signs of dementia (other 
than the fact she works with us).  Find out more below.

There is more though: the regex gang hit XLOOKUP and XMATCH, and we also demonstrate a cool trick which has proved very popular on the 
interwobble for turning numbers into words using a very obscure function and a very new one.

And then there is everything else.  We have the usual Beat the Boredom Challenge, Charts & Dashboards tips, Excel 
for Mac, Visual Basics, Power Pivot Principles, Power Query Pointers, the new Over to AI, Power BI Updates, Excel 
Updates, plus the A to Z of Excel functions and Keyboard Shortcuts continue to run amok.

As always, happy reading and remember: stay safe, stay happy, stay healthy.
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At the time of writing, our latest Excel Virtually Global conference 
continues to gain momentum.  We’re recruiting the presenters as we 
speak and we already have representatives from each and every continent 
(no, I am old school: Antarctica isn’t a continent)!  This conference, as 
always for charity, presents many Excel, Data Platform and PowerPoint 
MVPs, together with other acknowledged experts from Microsoft and / 
or around the globe to present, answer questions and demonstrate the 
future of Excel, Power BI, Fabric, ChatGPT, Copilot and Python and how 
it will make your life easier, personally and professionally.

Each session (including Q&A) will last no more than an hour and topics 
will cover all expertise levels, from novice to expert.  Most presenters are 
well known in their spheres, and have written blogs, books and articles 
and / or present video sessions.

Sessions this year will both be live and recorded.  You will be able to 
watch them later with downloads aplenty – there are no medals for 
staying up to watch the entire event live!  That’s just as well, as it will last 
a few days in the week commencing Monday 7 October, 2024.  

From your own favourite chair, bring a laptop, an inquisitive mind and 
your sense of humour.  Be prepared to learn heaps.  And remember, 
it's for charity – this year, there is no ticketing process: all we ask is an 
“honesty box” where you donate to your favourite charity.

For more details (e.g. times, speakers, sessions), please go to  
www.excelvirtuallyglobal.com.  The links will go live nearer the time, so 
keep checking back as the program may change too.

Hopefully, we’ll see you there!

Excel Virtually Global 2024
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She doesn’t look it, does she..?  face-smile

Congratulations to SumProduct’s very own Kathryn Newitt who has just 
contributed / co-contributed her 400th Power Query / Get & Transform 
article.  Yes, back in December 2016, Kathryn had a crazy idea to teach 
the world to mind their P’s & Q’s as it will save them heaps of time 
extracting, loading and transforming their data for forecasting, planning 
and analysis purposes.

She’s forgotten more than most of us will ever know on Power Query 
and she has no plans to stop the series any time soon.  You can check 
out her latest article in Blog and her archived articles are all present and 
correct here.

On behalf of everyone here at SumProduct, we’d like to thank her for her 
brilliant contributions and technical prowess.  Long may they reign and 
here’s to hoping Microsoft will soon recognise her as the PQ expert she 
is!  I feel an MVP nomination coming on…

Congratulations Kathryn!

At SumProduct, you can rely on our experience and willingness to help - 
simply drop us a line at contact@sumproduct.com.  

As we have explained in recent newsletters, the term “regex” is an 
abbreviation of “regular expressions” and is a language used for 
pattern-matching text content.  It is frequently implemented in various 
programming languages such as C, C++, Java, Python, VBScript – and of 
course, that latest and greatest software, Excel!

Microsoft has stated that the version of Regex coming to Excel uses a 

“flavor” (sic) called PCRE2 (PHP>=7.3) for those that need to know the 
underlying technical stuff.  

To use this fully, you need to understand the syntax for regular 
expressions.  Here is a crash course table, which summarises some – but 
not all – of the main elements, usually referred to as “tokens”.

Kathryn Hits 400

New Regex Modes for XLOOKUP and XMATCH

Token Meaning

\ This converts special characters (metacharacters) to literal characters, and also allows the 
literal matching of the regex delimiter in use, e.g. ‘/’

. Matches any character other than newline

^ Matches the start of string without consuming any characters.  If multiline mode is used, 
this will also match immediately after a newline character

$ Matches the end of string without consuming any characters.  If multiline mode is used, this 
will also match immediately before a newline character

a? Matches zero [0] or one [1] of a.  This matches an ‘a’  character or nothing

a* Matches zero [0] or more of a.  This matches zero or consecutive ‘a’ characters

a+ Matches one [1] or more of a.  This matches consecutive ‘a’ characters

a{4} Matches exactly four [4] instances of ‘a’

a{4,} Matches four [4] or more instances of ‘a’

a{4,6} Matches between four [4] and six [6] instances of ‘a’

\A Matches the start of a string only.  Unlike ^, this is not affected by multiline mode

\Z Matches the end of a string only.  Unlike $, this is not affected by multiline mode

\z Matches the absolute end of a string only.  Unlike $, this is not affected by multiline mode 
and in contrast to \Z, this will not match before a trailing newline at the end of a string

\b Matches a word boundary.  It matches without consuming any characters, immediately 
between a character matched by \w and a character not matched by \w.  It cannot be used 
to separate non-words from words
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Token Meaning

\B Matches a non-word boundary.  It matches without consuming any characters , at the 
position between two characters matched by \w or \W

i A case insensitive match is performed

x Ignore whitespace / verbose.  This flag instructs the engine to ignore all whitespace and 
allow for comments in the regex, also known as verbose.  Comments are indicated by 
starting with the # character and then escaping with \

xx Ignore all whitespace / verbose.  Similar to x, but whitespace is also ignored inside of 
character classes

s Known as single line, this enables the dot (.) metacharacter to also match newlines, thus 
treating the whole string as a single line input

\n Matches a newline character

\N Matches anything other than a newline character

\r Matches a carriage return, Unicode character U+2185

\R Careful!  Matches any Unicode newline sequence

\t Matches a tab character (typically, tab stops happen every eight [8] characters)

\0 [zero] Matches a null character, Unicode character U+2400

\d Matches any decimal / digit.  Equivalent to [0-9]

\D Matches anything other than a decimal / digit

\s Matches any whitespace character (space, tab or newline)

\S Matches any non-whitespace character (anything other space, tab or newline)

\w Matches any word character (any letter, digit or underscore).  Equivalent to [a-zA-Z0-9_]

\W Matches any non-word character (anything other than a letter, digit or underscore).  
Equivalent to [^a-zA-Z0-9_]

[abc] Matches an ‘a’, ‘b’ or ‘c’ character

[^abc] Matches any character except ‘a’, ‘b’ or ‘c’

a|b Alternate match: matches what is before or after |, in this case ‘a’ or ‘b’

[a-z] Matches any characters between a and z inclusive

[^a-z] Matches any characters, except those in the range a to z inclusive

[a-zA-Z] Matches any characters between a to z or A to Z inclusive

[[:alnum:]] Double square brackets are required here.  Matches letters and digits.  This is 
equivalent to [A-Za-z0-9]

[[:alpha:]] Matches letters.  Equivalent to [a-zA-Z]

[[:ascii:]] Matches any character in the valid ASCII range (any basic Latin character).  ASCII codes 0 
to 127 inclusive

[[:blank:]] Matches spaces and tabs (but not newlines).  Equivalent to [ \t]

[[:cntrl:]] Matches characters that are often used to control text presentation, including newlines, 
null characters, tabs and the escape character

[[:digit:]] Matches decimal / digits.  Equivalent to [0-9] or \d

[[:graph:]] Matches visible characters (not space: printable, non-whitespace, non-control 
characters only)

[[:lower:]] Matches lowercase letters.  Equivalent to [a-z]

[[:print:]] Matches printable characters, part of the basic Latin set, such as letters and spaces, but 
not including control characters

[[:punct:]] Matches visible punctuation characters that are not whitespace, letters or numbers

[[:space:]] Matches whitespace characters.  Equivalent to \s

[[:upper:]] Matches uppercase letters.  Equivalent to [A-Z]

[[:word:]] Matches word characters (letters, numbers and underscores).  Equivalent to \w or 
[a-zA-Z0-9_]

[[:<:]] Matches the start of word

[[:>:]] Matches the end of word

(?:…) Match everything enclosed.  For example, repeating 1-3 digits and a period 3 times can 
be identified as follows:

/(?:\d{1,3}\.){3}\d{1,3}/

(…) Capture everything enclosed
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Now that I have provided a refresher, regular expressions are starting to infiltrate Excel.  It began with three new functions:

	 1. 	 REGEXEXTRACT(text, pattern, [return_mode], [ignore_case])
	 2. 	 REGEXREPLACE(text, pattern, replacement, [occurrence], [ignore_case]) 
	 3.	 REGEXTEST(text, pattern, [ignore_case]).

However, now you may take further advantage of regex within the existing XLOOKUP and XMATCH functions, by using the new match_mode = 3 
and a regex pattern as the lookup_value.

This will allow XLOOKUP and XMATCH to match against parts of text in a cell, or by any other pattern of text that can be described with regex.

Here is one example we’ve all been desperate for: fuzzy matching, i.e. a search technique used to identify similar text strings, such as looking for a 
reference to Australia, such as “Aussie”, “Australia” or “Oz”.

Consider the following Table of data called Country_Sales_Data:

Here, I have created a formula in cell H24 which has determined the sales for the first record that contains an aforementioned reference to Australia:

=XLOOKUP("Aussie|Australia|Oz",Country_Sales_Data[Country],Country_Sales_Data[Sales],,3)

Note that the fifth argument (match_mode) is three [3], which is the new Regex match.

"Aussie|Australia|Oz" is the regular expression (in quotation marks) that provides alternate matches (see above Regex tokens table).  It does not 
matter which order these three alternatives are cited: XLOOKUP will seek out the first match, which in this case is the very first record.

XMATCH works similarly in cell H26, viz.

=XMATCH("Aussie|Australia|Oz",Country_Sales_Data[Country],3,-1)

Again, note that the third argument (match_mode) is three [3], which is the new Regex match.  The fourth argument (search_mode) is -1 here, so 
that XMATCH searches last to first.

This is great, but I am not keen on hard code, so it got me thinking: how about I create a table of date for all my fuzzy match acceptable alternatives?  
Well, that’s precisely what I did:
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There is a new Table here called Another_Table (I’m nothing if not unimaginative).  Then, in cells J35:L43, I have provided an input data table for 
alternative names for the countries Australia, Germany and USA.  In the shaded cells J44:L44, I have created three hidden formulae.  For example, 
the formula in cell J44 is

=TEXTJOIN("|",TRUE,J36:J43)

This uses the TEXTJOIN function to create a text string of all non-blank values in the range J36:J43 separating them with | and ignoring blanks.  This 
provides the albeit hidden result:

Aussie|Australia|Oz|Down Under|Lucky Country

Each of these three cells has been given a range name: Australia (cell J44), Germany (cell K44) and USA (cell L34).  I have then created a drop-down 
data validation list (ALT + D + L or Data -> Data Validation from the Ribbon):

The INDIRECT function is then employed in the corresponding XLOOKUP and XMATCH functions.  INDIRECT allows the creation of a formula by 
referring to the contents of a cell, rather than the cell reference itself.  

The sales figure in cell H51 is calculated as

=IFERROR(XLOOKUP(INDIRECT(H49),Another_Table[Country],Another_Table[Sales],"",3),"")

Similarly, the final occurrence formula in cell H53 is given by

=IFERROR(XMATCH(INDIRECT(H49),Another_Table[Country],3,-1),"")

This means that I can switch the country without having to revise the Regex code:

Some people aren’t keen on INDIRECT as it is both volatile (i.e. it recalculates whenever something changes in the file) and is non-auditable (i.e. it 
“fools” Excel’s built-in audit tools).  Therefore, an alternative (using Yet_Another_Table as the Table data source) would be the following:
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Here, we swap out the lookup_value in both the XLOOKUP and XMATCH functions which uses INDIRECT for a “nested” XLOOKUP expression instead.  
Thus, cell H78 contains the formula

=IFERROR(XLOOKUP(XLOOKUP(H76,J62:L62,J71:L71), 
Yet_Another_Table[Country],Yet_Another_Table[Sales],"",3),"")

and cell H80 contains the revised formula

=IFERROR(XMATCH(XLOOKUP(H76,J62:L62,J71:L71),Yet_Another_Table[Country],3,-1),"")

Of course, fuzzy matching is just one use of the new features in XLOOKUP and XMATCH.  I can go hunting for text strings that include inadvertent 
non-numerical values.  For example, consider the data Table called Data:

Here, the formula in cell H103 identifies the first record that contains a non-numerical value:

=IFERROR(XMATCH("[^0-9]",Data[Part Number],3),"All numerical.")

[^0-9] simply means find something that is not the numbers zero [0] to nine [9].  Once this has been located, I can then use the INDEX function to 
identify it in cell H105:

=IFERROR(INDEX(Data[Part Number],H103),"n/a")

I have made the non-numerical value deliberately difficult to spot:

154545545425O557454

That’s right: that is the capital letter O, not a zero [0]!  It didn’t fool Excel.

Of course, you can get more complex:

Here, for the Table Text_Data, I have used the formula 

=IFERROR(XMATCH("(\w*([a-zA-Z])\2\w*)",Text_Data[Text],3),"No instances.")

in cell H128.  Take my word for it, but the expression 

(\w*([a-zA-Z])\2\w*)

seeks out any text string that contains adjacent repeated letters that are either both lower case or both upper case (hence “apple” is not recognised 
but “Cheese” is).  Try it for yourself; I am sure you can construct even more complex monstrosities!
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Word to the Wise

Of course, you will all whinge at me when you discover you don’t have this feature – yet.  These new function modes are in Preview only presently. 
Their results may change substantially before being widely released, based upon Insider Beta users’ feedback.  Thus, I do not recommend using these 
functions in important workbooks until they become Generally Available.

 Presently, these functions are rolling out to Beta Channel users running: 

	 •	 Windows: Version 2408 (Build 17931.20000)

	 •	 Mac: Version 16.89 (Build 24080715).

Don’t let it deter you though!

One of the most common questions we are ever asked is how to translate a number into words, e.g.

You may even have encountered this problem for yourself.  Microsoft suggests you write VBA code to create a user-defined function (let’s not 
assume they’d actually create a function!):

Option Explicit

'Main Function

Function SpellNumber(ByVal MyNumber)

    Dim Dollars, Cents, Temp

    Dim DecimalPlace, Count

    ReDim Place(9) As String

    Place(2) = " Thousand "

    Place(3) = " Million "

    Place(4) = " Billion "

    Place(5) = " Trillion "

    ' String representation of amount.

    MyNumber = Trim(Str(MyNumber))

    ' Position of decimal place 0 if none.

    DecimalPlace = InStr(MyNumber, ".")

    ' Convert cents and set MyNumber to dollar amount.

    If DecimalPlace > 0 Then

        Cents = GetTens(Left(Mid(MyNumber, DecimalPlace + 1) & _

                  "00", 2))

        MyNumber = Trim(Left(MyNumber, DecimalPlace - 1))

    End If

    Count = 1

    Do While MyNumber <> ""

        Temp = GetHundreds(Right(MyNumber, 3))

        If Temp <> "" Then Dollars = Temp & Place(Count) & Dollars

        If Len(MyNumber) > 3 Then

            MyNumber = Left(MyNumber, Len(MyNumber) - 3)

        Else

            MyNumber = ""

        End If

Turning Numbers into Words
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        Count = Count + 1

    Loop

    Select Case Dollars

        Case ""

            Dollars = "No Dollars"

        Case "One"

            Dollars = "One Dollar"

         Case Else

            Dollars = Dollars & " Dollars"

    End Select

    Select Case Cents

        Case ""

            Cents = " and No Cents"

        Case "One"

            Cents = " and One Cent"

              Case Else

            Cents = " and " & Cents & " Cents"

    End Select

    SpellNumber = Dollars & Cents

End Function

      

' Converts a number from 100-999 into text 

Function GetHundreds(ByVal MyNumber)

    Dim Result As String

    If Val(MyNumber) = 0 Then Exit Function

    MyNumber = Right("000" & MyNumber, 3)

    ' Convert the hundreds place.

    If Mid(MyNumber, 1, 1) <> "0" Then

        Result = GetDigit(Mid(MyNumber, 1, 1)) & " Hundred "

    End If

    ' Convert the tens and ones place.

    If Mid(MyNumber, 2, 1) <> "0" Then

        Result = Result & GetTens(Mid(MyNumber, 2))

    Else

        Result = Result & GetDigit(Mid(MyNumber, 3))

    End If

    GetHundreds = Result

End Function

      

' Converts a number from 10 to 99 into text. 

Function GetTens(TensText)

    Dim Result As String

    Result = ""           ' Null out the temporary function value.

    If Val(Left(TensText, 1)) = 1 Then   ' If value between 10-19...

        Select Case Val(TensText)

            Case 10: Result = "Ten"

            Case 11: Result = "Eleven"
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            Case 12: Result = "Twelve"

            Case 13: Result = "Thirteen"

            Case 14: Result = "Fourteen"

            Case 15: Result = "Fifteen"

            Case 16: Result = "Sixteen"

            Case 17: Result = "Seventeen"

            Case 18: Result = "Eighteen"

            Case 19: Result = "Nineteen"

            Case Else

        End Select

    Else                                 ' If value between 20-99...

        Select Case Val(Left(TensText, 1))

            Case 2: Result = "Twenty "

            Case 3: Result = "Thirty "

            Case 4: Result = "Forty "

            Case 5: Result = "Fifty "

            Case 6: Result = "Sixty "

            Case 7: Result = "Seventy "

            Case 8: Result = "Eighty "

            Case 9: Result = "Ninety "

            Case Else

        End Select

        Result = Result & GetDigit _

            (Right(TensText, 1))  ' Retrieve ones place.

    End If

    GetTens = Result

End Function

     

' Converts a number from 1 to 9 into text. 

Function GetDigit(Digit)

    Select Case Val(Digit)

        Case 1: GetDigit = "One"

        Case 2: GetDigit = "Two"

        Case 3: GetDigit = "Three"

        Case 4: GetDigit = "Four"

        Case 5: GetDigit = "Five"

        Case 6: GetDigit = "Six"

        Case 7: GetDigit = "Seven"

        Case 8: GetDigit = "Eight"

        Case 9: GetDigit = "Nine"

        Case Else: GetDigit = ""

    End Select

End Function

Yuck.
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Others on the internet will suggest you can use a recursive LAMBDA function, let’s call it NUMBERTEXT, which can do something similar up to a 
given value, e.g.

=LAMBDA(num, LET(singleDigits, {"Zero","One","Two","Three","Four","Five","Six","Seven","Eight","Nine"}, teens, 
{"Ten","Eleven","Twelve","Thirteen","Fourteen","Fifteen","Sixteen","Seventeen","Eighteen","Nineteen"}, tens, 
{"","","Twenty","Thirty","Forty","Fifty","Sixty","Seventy","Eighty","Ninety"}, units, MOD(num, 10), tensPlace, MOD(INT(num / 10), 10), 
hundredsPlace, MOD(INT(num / 100), 10), thousandsPlace, MOD(INT(num / 1000), 1000), millionsPlace, INT(num / 1000000), words, 
IF(num < 10, INDEX(singleDigits, num + 1), IF(num < 20, INDEX(teens, num - 9), IF(num < 100, INDEX(tens, tensPlace + 1) & IF(units <> 0, "-" 
& INDEX(singleDigits, units + 1), ""), IF(num < 1000, INDEX(singleDigits, hundredsPlace + 1) & " Hundred" & IF(MOD(num, 100) <> 0, " " & 
NUMBERTEXT(MOD(num, 100)), ""), IF(num < 1000000, NUMBERTEXT(INT(num / 1000)) & " Thousand" & IF(MOD(num, 1000) <> 0, " " & 
NUMBERTEXT(MOD(num, 1000)), ""), IF(num < 10000000, NUMBERTEXT(millionsPlace) & " Million" & IF(MOD(num, 1000000) <> 0, " " & 
NUMBERTEXT(MOD(num, 1000000)), ""), "Number out of range")))))), words))

Nice.

I have something much simpler and mine even remembers adding words such as “and”:

Assuming the formula is in cell B2 (as above):

=SUBSTITUTE(TRANSLATE(BAHTTEXT(B2),"th","en")," baht","")

How cool is that?

BAHTTEXT is a truly random function in Excel that converts a number to Thai text and adds a suffix of "Baht".  You can change the Baht format to 
a different style in the Excel desktop application by using Regional and Language Options (Windows Start menu, Control Panel).  It employs the 
following syntax to operate:

BAHTTEXT(number)

The BAHTTEXT function has the following argument only:

	 •	 number: this is required and represents a number you want to convert to text, or a reference to a cell containing a number, or a formula 	
		  that evaluates to a number.

So, I thought why not use the new TRANSLATE function to translate Thai to English (or any other language you wish)?

For those not familiar with this brand new function, suppose you have the following text in cell A1: 

"Hello, World!"

and you want to translate it to Spanish.  You can use the TRANSLATE function as follows:

=TRANSLATE(A1, "en", "es")

In this example, the source language is English (en) and the target language is Spanish (es).  The translated text, "Hola mundo!" will be displayed in 
the cell where you entered the formula.

Alternatively, you may just type the text in, viz.
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We can take this idea with BAHTTEXT:

Then, all you need to do is remove “baht” from the text at the end (I use the SUBSTITUTE function to do this).

Before everyone starts cheering from the rooftops, there are some issues.  Some numbers don’t seem to work (e.g. 10,014 and those with decimals) 
– but hey, it’s a start and greater minds will bulldoze these scenarios in time.  Also, I should point out that TRANSLATE is not yet available in all 
versions of Excel.  At the time of writing, this function is only available to Beta Channel users of Excel 365 running: 

	 •	 Windows: Version 2407 (Build 16.0.17808.20000) or later 
	 •	 Mac: 16.87 (Build 24062430) or later.

But it’s coming!!

Simple!

Word to the Wise

With many of us currently “working from home” / quarantined, there are only so Zoom / Teams calls and virtual parties you can make before you 
reach your (data) limit.  Perhaps they should measure data allowance in blood pressure millimetres of mercury (mmHg).  To try and keep our readers 
engaged, we will continue to reproduce some of our popular Final Friday Fix challenges from yesteryear in this and upcoming newsletters.  One 
suggested solution may be found later in this newsletter.  Here’s this month’s…

Beat the Boredom Challenge
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Filtering data in a Table in Excel is as easy as clicking the filter button then ticking the data you want, right?  However, if you want to see all but a 
few choice options in a field with many different entries, you may find yourself scrolling tirelessly to find and untick the few you don’t want to see.  
Luckily, there are several ways to filter data based off of a list of values to exclude, which can be achieved using only formulae.  

This month’s challenge is to write a formula to replicate data in a Table, removing entries as specified in a second Table.  The starting Table (here, 
imaginatively called Data) might be as follows:

The data to remove Table (named Remove) may look like this:

The result, using the current inputs, should look similar to the below:
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As always, there are some requirements:

	 •	 the formula needs to be within just one cell (no “helper” cells)

	 •	 this is a formula challenge; no Power Query / Get & Transform or VBA

	 •	 the formula should be dynamic enough to update when entries are added to the Remove Table
	 •	 anyone with Excel 365 should be able to use the solution.

Sounds easy?  Try it.  One solution just might be found later in this newsletter – but no reading ahead!  

Here at SumProduct we write many articles for many magazines and our authoring contracts have been revised recently to ensure Artificial Intelligence 
hasn’t taken over our duties.  We can assure everyone they have not.  They’d never sound as robotic as our stuff.  Exterminate, exterminate!

But it did get us thinking: what if we did let AI loose and write a regular article for the newsletter?

Excel is a powerful spreadsheet application that can perform various calculations and operations on data.  However, sometimes you may want to 
convert numbers to text, for example, to display them in a different format, to concatenate them with other strings, or to use them in formulae that 
require text arguments.

One way to convert numbers to text in Excel is to use the built-in TEXT function, which takes a number and a format code as arguments and returns 
the number as a text string formatted according to the code. For example, =TEXT(1234.56,"$#,##0.00") will return "$1,234.56" as a text string.

However, the TEXT function has some limitations, such as:

	 •	 it only works with predefined format codes, which may not suit your needs

	 •	 it does not preserve the original value of the number, which may cause errors or inconsistencies in calculations

	 •	 it does not work with arrays or ranges of numbers, which may require you to enter the formula for each cell individually.

A better way to convert numbers to text in Excel is to create a custom 
function using Visual Basic for Applications (VBA), which is a programming 
language that allows you to extend the functionality of Excel. A custom 
function, also known as a user-defined function (UDF), can take any 
number of arguments, perform any calculations or operations and return 
any value as a result.  You can use a custom function in the same way as 
any built-in function in Excel, such as by entering it in a cell, in a formula, 
or in a named range.

Here, we will show you how to write a custom function in VBA that 
converts numbers to text, and how to use it in Excel.  We will also 
explain the advantages and disadvantages of using a custom function 
and provide some tips and best practices for writing and using custom 
functions in Excel.

So that’s what we’ve done.  See what you think.  We thought AI could have a go at this month’s salient topic, turning numbers into words…

This Month’s Prompt: How to Write an Excel Formula that Converts Numbers to Text

INTRODUCTION

Over to AI



contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

HOW TO WRITE A CUSTOM FUNCTION IN VBA THAT CONVERTS NUMBERS TO TEXT

To write a custom function in VBA that converts numbers to text, you need to follow these steps:

	 1.	 Open the workbook where you want to use the custom function or create a new workbook

	 2.	 Press ALT + F11 to open the Visual Basic Editor, which is a separate window where you can write and edit VBA code
	 3.	 In the Project Explorer pane, which shows the structure of your workbook and its components, right-click on the name of your workbook 	
		  and select Insert -> Module.  This will create a new module, which is a container for your VBA code

	 4.	 In the Code window, which is where you write and edit your VBA code, type the following code.

Function NumToText(ByVal Number As Variant) As String

'This function converts a number to text using the SpellNumber function

'Number is the number to be converted

'The function returns the number as a text string

'If Number is not a valid number, the function returns an error message

'Declare a variable to store the result

Dim Result As String

'Check if Number is a valid number

If IsNumeric(Number) Then

'Use the SpellNumber function to convert the number to text

'The SpellNumber function is a hidden function in Excel that spells out a number in words

'For example, SpellNumber(123) returns "One Hundred Twenty-Three"

'The SpellNumber function is not documented or supported by Microsoft, so use it at your own risk

'To use the SpellNumber function, you need to add a reference to the Microsoft Scripting Runtime 
library

'To do this, go to Tools > References in the Visual Basic Editor and check the box next to 
Microsoft Scripting Runtime

Result = Application.Run("SpellNumber", Number)

Else

'If Number is not a valid number, return an error message

Result = "Invalid number"

End If

'Return the result as a text string

NumToText = Result

End Function

Save your workbook as a macro-enabled workbook, which has the file extension .xlsm.  This will allow you to use the custom function in your 
workbook.

HOW TO USE THE CUSTOM FUNCTION IN EXCEL

To use the custom function in Excel, you need to follow these steps:

	 1. 	 Open the workbook where you have saved the custom function or create a new workbook and save it as a macro-enabled workbook

	 2. 	 In a cell where you want to display the number as text, enter the custom function as follows: =NumToText(number), where number is the 	
		  number you want to convert to text.  For example, =NumToText(1234.56) will return "One Thousand Two Hundred Thirty-Four 		
		  and 56/100" as a text string

	 3. 	 Press ENTER to confirm the formula and display the result

	 4. 	 You can also use the custom function in other formulae, such as by concatenating it with other strings or by using it as an argument for 	
		  other functions that require text inputs.  For example, ="The total amount is "&NumToText(SUM(A1:A10)) will return "The total amount 	
		  is One Thousand Two Hundred Thirty-Four and 56/100" as a text string, where SUM(A1:A10) is the sum of the values in the range A1:A10

	 5. 	 You can also use the custom function with arrays or ranges of numbers, by entering it as an array formula.  To do this, select the cells 	
		  where you want to display the numbers as text, enter the custom function as follows: =NumToText(array), where array is the array or 	
		  range of numbers you want to convert to text and press CTRL + SHIFT + ENTER to confirm the formula.  For example, if you select the 	
		  range B1:B10 and enter =NumToText(A1:A10) and press CTRL + SHIFT + ENTER, the cells in B1:B10 will display the corresponding 	
		  numbers in A1:A10 as text strings.
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ADVANTAGES AND DISADVANTAGES OF USING A CUSTOM FUNCTION
Using a custom function in Excel has some advantages and disadvantages, such as the following.

Advantages

	 •	 You can create a custom function that suits your specific needs and preferences, and that is not available as a built-in function in Excel.

	 •	 You can use a custom function in the same way as any built-in function in Excel, such as by entering it in a cell, in a formula or in a named 	
		  range.

	 •	 You can use a custom function with arrays or ranges of numbers, which may save you time and effort compared to using the TEXT 	
		  function for each cell individually.

	 •	 You can use a custom function with other formulas, such as by concatenating it with other strings, or by using it as an argument for other 	
		  functions that require text inputs.

	 •	 You can modify or update your custom function at any time, by editing the VBA code in the Visual Basic Editor.

Disadvantages

	 •	 You need to have some basic knowledge of VBA and programming to write and edit a custom function.

	 •	 You need to save your workbook as a macro-enabled workbook, which may cause some compatibility or security issues with other 	
		  applications or users.

	 •	 You need to enable macros in your workbook, which may pose some security risks if the workbook contains malicious code.

	 •	 You may encounter some errors or bugs in your custom function, which may affect the accuracy or reliability of your results.

	 •	 You may not be able to use your custom function in other workbooks, unless you copy or import the module that contains the VBA code.

TIPS AND BEST PRACTICES FOR WRITING AND USING CUSTOM FUNCTIONS IN EXCEL

 Here are some tips and best practices for writing and using custom functions in Excel:

	 •	 use descriptive and meaningful names for your custom functions, and avoid using names that are already used by built-in functions or 	
		  other objects in Excel

	 •	 use comments in your VBA code to explain the purpose and logic of your custom function and to make it easier to read and understand

	 •	 use proper indentation and spacing in your VBA code to make it more organised and readable

	 •	 use error handling techniques in your VBA code to prevent or handle any errors or exceptions that may occur in your custom function

	 •	 test and debug your custom function before using it in your workbook and check the results for accuracy and consistency

	 •	 document and share your custom function with other users and provide instructions on how to use it and what to expect from it

	 •	 review and update your custom function regularly, and make sure it works as intended and meets your needs.

What do you think?  Do you agree?  (I am still trying to find those agreed best practices and standards for financial modelling…)  Send us your 
comments and ideas for questions to contact@sumproduct.com. 

With Steve Kraynak joining the team, we thought we would exploit his knowledge and recant all about Microsoft Excel for Mac.  Each month, we’ll 
cover a different topic to help you understand how Excel for Mac is different than Excel for Windows.  This month, we provide a list of keyboard 
shortcuts that are very helpful to know, especially if you’re using the keyboard on a MacBook.

When you’re using a MacBook, or any laptop, your keyboard is likely compact compared to a full desktop keyboard, so you may not have the keys for 
some well-known shortcuts, such as the Home, End and Page Up / Down keys.  We’ve compiled the list below to help you in that case.

Shortcuts for Editing:

	 •	 Delete the character to the right:  Fn + Delete or the “forward delete” key on extended keyboard

	 •	 Delete text to the end of the line:  CTRL + Fn + Delete or Control + the “forward delete” key

Excel for Mac

mailto:contact%40sumproduct.com?subject=
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	  •	 Move to the beginning of the line of text:  Home or Fn + Left Arrow	  

Shortcuts for navigating:

	  •	 Move to the beginning of the row:  Home or Cmd + Left Arrow or Fn + Left Arrow

	  •	 Move to the end of the row:  End or Cmd + Right Arrow or Fn + Right Arrow then Right Arrow (by itself)

	  •	 Move to A1 (first cell):  CTRL + Home or CTRL + Fn + Left Arrow

	  •	 Move to the “Last Cell”:  CTRL + End or CTRL + Fn + Right Arrow

	  •	 Move down one screen:  Page Down or Fn + Down Arrow

	  •	 Move up one screen:  Page Up or Fn + Up Arrow

	  •	 Move one screen to the right:  Option + Page Down or Fn + Option + Down Arrow

	  •	 Move one screen to the left:  Option + Page Up or Fn + Option + Up Arrow

	  •	 Move to the next sheet in the workbook:  CTRL + Page Down or Option + Right Arrow

	  •	 Move to the previous sheet in the workbook:  CTRL + Page Down or Option + Left Arrow.

We’ll continue next month…

We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.   
This month, we hold a bit of an Event…

While most VBA scripts tend to be triggered by buttons or commands that a user can execute, it can also be programmed to run when a particular 
action is triggered elsewhere in the Excel workbook.  We referred to this earlier in the series and will now address the process of creating these 
events.

These triggers can be found in the VBA Editor and navigating to a Sheet or to ThisWorkbook.

Worksheet events

There are a couple of key worksheet events generally used:

	 •	 Activate
	 •	 SelectionChange.

The Activate event will trigger whenever the worksheet in question is activated (e.g. if a user clicks on the worksheet tab in Excel).  

This sort of event can be used to trigger an update or clean-up of data 
on a sheet.  It is commonly used to refresh PivotTables when a sheet 
is selected, with the code cycling through available PivotTables and 
refreshing each one.

The SelectionChange triggers whenever a new cell is selected within the 
worksheet, e.g. when a cell is clicked on or when the selection range 

is expanded or reduced.  This event is a bit different, in that there is 
also an additional parameter that becomes available, initially referred 
to as “ByVal Target as Range”.  This allows you to pass the selected area 
througha to the VBA script being run.  An example of this can be found in 
a previous blog that we’ve written (https://www.sumproduct.com/blog/
article/vba-blogs/painting-with-excel).

Visual Basics

https://www.sumproduct.com/blog/article/vba-blogs/painting-with-excel
https://www.sumproduct.com/blog/article/vba-blogs/painting-with-excel


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Workbook events

There are several key workbook events that are commonly used in practice:

	 •	 Activate
	 •	 BeforeClose
	 •	 BeforeSave
	 •	 Open.

In particular, the Open event is commonly used to set up disclaimer messages, user guides and instructions, or for model clean-up.  However, this 
relies upon the user enabling macros prior to the macro attempts to run.  For a more robust process, any clean-up or disclaimer script should be 
written prior to the file being saved, so that any user will be required to respond to the disclaimer before the file can be used.

This is where the BeforeSave event is particularly useful.  The event is triggered upon a Save or SaveAs command and allows users to run any clean-up 
prior to the file being saved.  The macro can be set to restore the file after it has been saved, so that the user won’t need to go through the disclaimer 
process, resulting in a seamless save action.

Disabling events

While events can be useful, at times you may need to save the file as part of another macro script, assuming that the event will not be triggered.  
In these instances, you need to include the command:

Application.EnableEvents = False

This will prevent any events from being triggered until you restore the actions using:

Application.EnableEvents = True

If you decide to switch off events at the start of your macro to improve the speed and efficiency of your macro run, remember to switch it back on 
subsequently after your macro finishes running.

More next time.

It’s time to chart our progress with an introductory series into the world of creating charts and dashboards in Excel.  This month, we look at adding 
customised shapes to charts.

When creating charts in Excel, we only get the default shapes, e.g. quadrilateral or round shapes.  There is sometimes a good reason we want our 
charts to be uniquely customised to users’ needs.

For this example, let us consider a dataset of house sales (in $m) in the 12 months of 2020:

Charts and Dashboards
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First and foremost, highlight the range A2:B13, navigate to the Insert tab on the Ribbon and select a column chart, or else, hold the ALT + F1 keys to 
create the initial column chart like the one below:

Next, go to the ‘Chart Design’ contextual tab, point to the ‘Quick Layout’ and choose a layout to get the data labels, removing the vertical axis and 
gridlines.

The series legend is not necessary, so, click on it and hit Delete.  Click on the Chart Title and point it to cell B1 for a dynamic chart title (link to  
https://www.sumproduct.com/blog/article/charts-and-dashboards-blogs/cd-dynamic-chart-titles).  We also want to change the colour of the data 
series, so let’s click on them, go to the Format contextual tab and change the ‘Shape Fill’ colour to our likings. 

Now, we want the data series to draw the shape like a roof of a house to make the chart more relatable and memorable.  Go to the Insert tab, choose 
the ‘Arrow: Pentagon’ shape, draw it somewhere on the sheet, rotate it by 90 degree and change the shape colour to exactly the same colour as our 
chart’s data series.

https://www.sumproduct.com/blog/article/charts-and-dashboards-blogs/cd-dynamic-chart-titles
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First and foremost, highlight the range A2:B13, navigate to the Insert tab on the Ribbon and select a column chart, or else, hold the ALT + F1 keys to 
create the initial column chart like the one below:

To get this pentagon shape to my chart, click on the shape and press CTRL + C keys to copy, then click on the data series

and hold the CTRL + V keys to paste. 

Our chart data series now get the ‘roof’.
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… Wait, do they look unequal?  The higher the sales, the more the shape stretches and the pointier the roof is.  This is not quite what we want, so let’s 
keep editing.  We need to separate the column into two parts, say Roof and Floor, in which the Roof parts are all equal to prevent the above stretch.  

The Roof part should be formula-driven rather than a fix number.  In this case, we will get the minimum sales of twelve months and divided it by two 
[2] since we have two parts (otherwise, the house will only have a roof without a floor!). The formula in cell C2 is

=MIN($B$2:$B$13)/2

and the Floor part, cell D2, equals B2-C2. 

Now that we have the data, we will create a stacked column chart based on the two separated parts, we will have an initial chart like the one below.

We will copy the roof shape to the Roof series similar to the above: 
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We will copy the roof shape to the Roof series similar to the above: 

Next, we will paint the Floor series the same colour as the Roof, reduce the Gap width between the columns and get the dynamic chart title  
(https://www.sumproduct.com/blog/article/charts-and-dashboards-blogs/cd-dynamic-chart-titles) pointing to cell B1.  The chart looks better now.

More next time.

We continue our series on the Excel COM add-in, Power Pivot.  This month, we show you how the LASTDATE function works.

The LASTDATE function is a time intelligence function, just like last month’s DATESINPERIOD function.  The LASTDATE function uses the following 
syntax to operate:

LASTEDATE(date)

The date parameter must be a column with dates.  The date parameter 
can also be a table expression that will return a single column of dates.  
The LASTDATE function returns with a table containing a single row and 
column with the latest date value from the input column from the date 
parameter.

Last time, we used the MIN function to determine the earliest date in 
the column.  So why would we use the LASTDATE function?  Well, we can 
use the LASTDATE function with other expressions that require a table 
input and not a scalar input.  The other reason is that we can use filter 
functions that return with a table as the date input.  Let’s say that we 
wish to retrieve the last date from the following dataset: 

Power Pivot Principles

https://www.sumproduct.com/blog/article/charts-and-dashboards-blogs/cd-dynamic-chart-titles
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We can use this measure:

=LASTDATE(SaleDataJul1[Date])

Inserting this measure into a PivotTable:



contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

It just returns with the respective row’s date, this is because the measure, as it stands, is subject to the row filters. If we remove the date column, we 
can see that the measure is returning with the last date in our data:

It seems that we will need to make some adjustments to our measure for it to return with the last date on each row:

=LASTDATE( 
                      ALL( 
                              SaleDataJul1[Date] 
                             ) 
                     )
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Including this measure in our PivotTable yields:

We have included the ALL function, so that it forces the LASTDATE function to disregard the row filters on each row.  We can now use this measure 
to create more complex calculations in DAX, but more on that anon.

That’s it for this month; more next time.  

Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from  
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we consider 
how text output may be presented.
 
Previously, we have created the simplest piece of M code:

The output is recognised by Power Query as text, and text tools are available.

Power Query Pointers

http://www.sumproduct.com/blog
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If we wish to manipulate the presentation of this text string, there are some other simple methods we may use. 

If we type “Hello” and “World” in separate lines in the Advanced Editor, the text is split over two lines.  If we look at the step for this line of syntax, 
the code looks a little different:
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The M code is actually stored as

=  "Hello #(lf)World"

The text has been manipulated with an escape sequence.  There are a number of definitions of escape sequences; this is the Microsoft version:

Escape sequences are typically used to specify actions such as carriage returns and tab movements on terminals and printers. They are 
also used to provide literal representations of nonprinting characters and characters that usually have special meanings, such as the 
double quotation mark (").

In this case, the escape sequence #(lf) is telling power query to insert a linefeed.  This is one of three control escape codes supported by Power Query, 
the others are:

	 •	 #(cr) 	 carriage return

	 •	 #(tab)	 tab.

 
In the next screen, we use a tab instead of the linefeed:

We may also combine the escape codes into a sequence.

= "Hello #(lf)#(tab)World"

This applies a linefeed and then a tab.

We can also write this by grouping the escape sequences within the brackets (). 

= "Hello #(lf,tab)World"
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For those of us familiar with them, short and long hexadecimal Unicode values may also be used.  One definition of a hexadecimal in a computing 
context is:

Hexadecimal is a convenient way to express binary numbers in modern computers in which a byte is almost always defined as containing 
eight binary digits.

Hexadecimals can represent a variety of characters.  A simple example is the hexadecimal for a space, which in its long form is 00000020, and in in 
its short form is 0020.

In the previous screenshot, the escape sequences only appear in the Advanced Editor, although we typed them into the step!

= "Hello #(00000020,0020)World"

There are times when we may want the actual characters to appear, rather than be translated – this can apply to double quotes “ or the beginning 
of an escape sequence #(.  In each case, the answer is add more!
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In order to output “Hello World” complete with the speech marks, in the Advanced Editor we need to type 

“””Hello World”””

For the escape code #(lf) to appear, we need to add the escape code (#) between the # and the (lf).  Whilst we are unlikely to want to output escape 
sequences, users do have a habit of using a ‘special’ character in reference numbers!

Until next month.

It’s that time of the month again.  This month’s updates see you now able to ask Copilot questions against your semantic model.  But there is always 
more.  For example, updated Save and ‘Upload to OneDrive Flow’ in Power BI, plus the Narrative visual with Copilot is now available in SaaS embed.

The full list of updates is as follows:

Ask Copilot questions against your semantic model (Preview)

You can now ask Copilot for data from your entire semantic model in Power BI Desktop.  Simply tell Copilot what you’re looking for and Copilot will 
query your model to answer your question with a visual.

Since the Copilot pane in Desktop is still in Preview, you do not need to turn on the Preview toggle to use this new capability.

Copilot and AI
	 •	 Ask Copilot questions against your semantic model (Preview)

Reporting
	 •	 Visual level format strings (Preview)
	 •	 Dynamic per recipient subscriptions (Generally Available) 
	 •	 Deliver subscriptions to OneDrive and SharePoint (Generally 	
	 	 Available)
	 •	 Updated Save and ‘Upload to OneDrive Flow’ in Power BI 
	 •	 Data limit
	 •	 Visuals, shapes and line enhancements    

Modelling
	 •	 DAX query view in the web  	
	

Embedded Analytics

	 •	 Narrative visual with Copilot available in SaaS embed

Visualisations
	 •	 New visuals in AppSource
	 •	 Filter by Powerviz
	 •	 Pie of Pie by JTA
	 •	 Drill Down Pie PRO by ZoomCharts
	 •	 Hierarchical Bar chart
	 •	 Deneb: Declarative Visualization in Power BI

Other

	 •	 Paginated Reports: sharing of reports connecting to Get Data 	
	 	 data sources made easy.

Let’s look at each in turn.

Power BI Updates
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This new capability supports a wide range of different types of analysis.  Whilst the exact questions which Copilot can answer will depend on the 
specifics of your model, here are some examples:

	 •	 Show me sales amount and profit for the last two [2] years

	 •	 What are the top three [3] product lines by customer rating?

	 •	 Which dairy product has the most profit in Australia?

You can also ask follow-up questions, such as “what are the total sales for 2024?” and then follow up with “can you show me this for Madagascar?”  
Copilot makes it easy to have a natural conversation about your data, like having a business analyst at your fingertips.
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If you happen to ask a question that can be answered by an existing visual within the report, Power BI will search and pinpoint you to that exact visual 
to help you quickly navigate and get immediate insights.

Once you receive the answer, you can expand the ‘show reasoning’ dropdown to learn more about how Copilot understood your question to build 
transparency between you and Copilot.  You can also expand the visual to see it in more detail, and as a report author, you can even add these visuals 
directly to your report page simplifying the report creation process – just click the ‘add to page’ button underneath the visual.

There may be occasions where Copilot misunderstands your question.  This could either be because it was not able to find the right data field or it 
misunderstood your intention.  In order to improve Copilot’s understanding, here are some suggestions and tips to get better results:

	 •	 use descriptive column names: try and avoid using columns which are not spaced or camel case

	 •	 use synonyms: if a column can have more than one meaning, use copilot synonyms found in the Q&A settings to automatically add 	
		  business domain terms

	 •	 if you have a very specific type of question that needs answering, create a visual on a report and use the title field to describe the 	
		  question it answers.  Then, Copilot will find this visual and use this as its basis for answering.



contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Visual level format strings (Preview)

Visual level format strings have now been added, providing you with more 
options to configure formatting.  Originally built for visual calculations, 
the core ability that visual-level format strings provide is the ability to 
format visual calculations.  Since visual calculations are not in the model, 

you could not format them, unless you were using them in data labels or 
in specific parts of the new card and new slicer visuals.  With visual level 
format strings, you can.

However, visual level format strings are useful even without using visual 
calculations.  With the introduction of visual-level format strings, Power 
BI now has three [3] levels for format strings:

	 1.	 Model.  You can set a format string for columns and measures  
		  in the model.  Anywhere you use that column or measure the  
		  format string will be applied, unless it’s overridden by a visual  
		  or element level format string

	 2.	 Visual.  This is the update.  You may set format strings on any  
		  column, measure or visual calculation that is on your visual,  
		  even if they already had a format string.  In that case, the model  
		  level format string will be overridden, and the visual level  
		  format string is used

	 3.	 Element.  You can set a format string for data labels and for  
		  specific elements of the new card and the new slicer visuals.   
		  This level will be expanded to include much more in the future.   
		  Any format string you set here will override the format string  
		  set on the visual and model level.

These levels are hierarchical, with the model level being the lowest 
level and the element level the highest.  A format string defined on a 
column, measure or visual calculation on a higher-level override what 
was defined on a lower level.

Since visual calculations are not in the model, they cannot have a format 
string set on the model level but can on the visual or element level.  
Measures and columns can have format strings on all three levels:

The image below summarizes this and shows that higher level format strings override lower-level format strings:

Level Impacts Available for
Measures / columns Visual calculations

Element Selected element of the selected visual X X

Visual Selected visual X X

Model All visuals / pages / reports on same model X
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Let’s look at an example using a measure.

Assume we have a Profit measure in our model, which is set to a decimal number format.  To do this, you might have set the formatting for this 
measure using the Ribbon:

Alternatively, you could have made the same selections in the Properties pane for the measure in the Model view or entered the following custom 
formatting code:

If you put this measure on a visual it now returns a decimal number, as expected:

However, on a particular visual you want that measure to be formatted as a whole number.  You can now do that by setting the format code on the 
visual level by opening the Format pane for that visual and the Data format options found there under General:
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Now that same measure shows as a whole number, but just on that visual:

Further, you might want to use a scientific notation for that measure but only in the data label on a particular visual.  No problem; you set the format 
code on the data label for that measure:
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Now, the total shows in scientific notation, but only in the data label and not in other places (such as the ToolTip as shown below).  Notice how the 
element level format is used in the data label but the visual or model level format string is still used for the other elements in the same visual.

For visual calculations the same principle applies but of course without the model level.  For example, if you have a visual calculation that returns a 
percentage, you can now format it as such using the ‘Data Format’ options in the General on the visual in the Format pane:

The ability to set visual level format strings makes it much easier to get 
the exact formatting you need for your visualisations.  However, this 
is only the first iteration of the visual level format strings.  Microsoft is 
planning to add the settings you’re used to for the model level format 
strings to the visual level soon.

Since visual level format strings are introduced as part of the visual 
calculations Preview, you will need to turn on the visual calculations 
Preview to use them.  To do that, go to Options and Settings -> Options 
-> Preview features.  Select ‘Visual calculations’ and then OK.  Visual 
calculations and visual level format strings are enabled after Power BI 
Desktop is restarted.
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Dynamic per recipient subscriptions (Generally Available) 

Microsoft has announced the General Availability of ‘Dynamic per 
recipient’ subscriptions for Power BI and paginated reports.  ‘Dynamic 
per recipient’ subscriptions is designed to simplify distributing a 
personalised copy of a report to each recipient of an email subscription.  
You define which view of the report an individual receives by specifying 

which filters are applied to their version of the report.  The feature is 
now available in Sov. Clouds as well.

You may create a ‘Dynamic per recipient’ with a simple drag and drop 
experience.  First, subscribe to the report by selecting ‘Subscribe to 
report’ and then ‘Create Subscriptions’.

Select the ‘Dynamic per recipient’ subscription.

Connect to data that has recipient email, names or report parameters.
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Then, select and filter data that you want in your subscription.  You probably only want to send emails conditionally.  To do that, you can filter the 
data in the Filter pane.

You can select the recipient email addresses and the email subject from the dataset that you connected to by selecting ‘Get Data’.
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You may then map your data to the subscription.
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Then schedule the subscription and save it.

The subscriptions will be triggered based upon the schedule that you have set up.  Personalised reports may be sent to up to a thousand recipients.

Deliver subscriptions to OneDrive and SharePoint (Generally Available)

Do you have reports that are too large to be delivered by email?  Do you have reports that are eating into your email in just a few weeks or do you 
need you to move it to a different location?  You can now deliver Power BI and paginated report subscriptions to OneDrive or SharePoint.  With this 
capability, you can schedule and send full report attachments to a OneDrive or SharePoint location.
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Updated Save and ‘Upload to OneDrive Flow’ in Power BI 

Having begun in early August, desktop users should see a Preview switch 
starting in SU8 to turn on the updated Save and ‘Upload to OneDrive’ 
experience in Power BI.  To enable this, navigate to the Preview features 
section of Options in Power BI. Users will then need to select ‘Saving to 
OneDrive and SharePoint uploads the file in the background’.

With these updates, Power BI has improved the experience of uploading 
new Power BI files to OneDrive, and easily upload new changes in the 
background.
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For uploading new files, after navigating to the correct location in the 
OneDrive file picker and saving, a dialog box appears while the file is 

being uploaded.  The option to cancel the upload is there if needed.  This 
dialog will only show up the first time a new file is uploaded to OneDrive.

When new changes are saved to a file uploaded to OneDrive, the top of the toolbar indicates that the new changes are also being uploaded to 
OneDrive.

If you click on the title bar flyout in the toolbar, you can also now access more information about the file.  Clicking ‘View your file in OneDrive’ will 
provide a direct link to where the file is stored in OneDrive.
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Data limit

This update should provide you with more control over your visuals.  Microsoft has introduced the data limit capability for managing potential 
performance issues.  With data limits, you set the maximum data load for a single session per visual.  

To flex this feature:

	 •	 navigate to the ‘Filters on this visual’ menu in the Filter pane

	 •	 click on the data limit menu and a new Filter card will pop up

	 •	 set your desired data limit value.

All the Filter card features are here:

	 •	 remove, lock or clear filters

	 •	 hide or show filters to keep things tidy

	 •	 expand or collapse Filter cards for a quick overview

	 •	 apply filters to zero in on what matters

	 •	 rename and reorder filters to suit your flow.

In particular, keep an eye on the filter visual header.  It will show you any data limits applied to your visual, even if the report creator decides to play 
hide and seek with the Filter pane.

Visuals, shapes and line enhancements    

Over the past few months, Power BI has been fine-tuning the visual elements of its reports—columns, bars, Ribbons and lines.  

With this latest update, legends and ToolTips are now improved.  Now, they will reflect the style enhancements you have applied to your visual 
shapes and lines. 

DAX query view in the web  

You may now write DAX queries on your published semantic models with DAX query view in the web.  DAX query view, already available in Power BI 
Desktop, is now also available when you are in the workspace.
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Look for 'Write DAX queries' on your published semantic model:

	 •	 right-click on the semantic model and choose ‘Write DAX queries’

	 •	 click on the semantic model to open the details page, then click ‘Write DAX queries’ at the top of the page.

This will launch DAX query view in the web, where you can write DAX queries, use quick queries to have DAX queries written for you on tables, 
columns or measures, or use Fabric Copilot to not only write DAX queries but explain DAX queries, functions or topics.  DAX queries work on semantic 
models in import, DirectQuery and Direct Lake storage mode.

Write permission, that is permission to make changes to the semantic 
model, is currently needed to write DAX queries in the web.  Also, the 
workspace setting, ‘User can edit data models in the Power BI service 
(preview)’, needs to be enabled.

DAX query view in the web includes DAX query view’s way to author 
measures.  Define measures with references, edit any of them and try 

out changes across multiple measures by running the DAX query, then 
update the model with all the changes in a single click of a button.  DAX 
query view in web brings this functionality for the first time to semantic 
models in Direct Lake mode.
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If you do not have write permission, you can still live connect to the semantic model in Power BI Desktop and run DAX queries there.

The Narrative visual with Copilot is now available for user owns data 
scenarios (SaaS) and secure embed.  This means when a user embeds a 
report containing the narrative visual in a solution where users must sign 
in they will now be able to the visual refresh with their data. 

When you embed a Power BI report in an application in the ‘embed 
for your organization’ scenario, it allows organisations to integrate 
interactive data visualisations seamlessly into their internal tools and 
workflows.  Now this solution supports the Copilot visual.  A sales team 
might want to embed a Power BI report in their internal CRM application to 
streamline their workflow.  By integrating sales performance dashboards 
directly into the CRM, team members can easily monitor key metrics 
like monthly sales targets, pipeline status and individual performance, 
without switching between different tools.  This integration enables 
quicker access to actionable insights, helping the team make informed 
decisions, identify trends and react swiftly to market changes, all within 
the secure environment of their organisation’s data infrastructure.

Supported scenarios include:

	 •	 embed a report in a secure portal or website Power BI

	 •	 user owns data: a user embeds a report containing the narrative  
		  visual in a solution where users must sign in.  They need a license  
		  to do so. This action is also known as embed for your  
		  organisation.  It includes when users want to embed visuals in 	
		  solutions like PowerPoint as well.

Unsupported scenario:

	 •	 app owns data:  a customer embeds a narrative visual on 		
		  a website where users visit and don’t need to sign in.  Also 		
		  known as ‘embed for your customer’s application’.

To get this set up, there are a few steps to follow so do hunt our Microsoft’s 
supporting documentation.  You will need to edit your Microsoft Entra app 
permissions to enable the embedded scenario to work.

Narrative visual with Copilot available in SaaS embed
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From here you’ll need to add the MLModel.Execute.All permission.

Once you do that, your visual should work in your embedded experiences where users still sign in. 

New visuals in AppSource

These include:

	 •	 Bubble Diagram

	 •	 Chord Diagram

	 •	 Image

	 •	 Non-Ribbon Chord Diagram

	 •	 Skyline

	 •	 StackedTrends Visual.

Filter by Powerviz

Powerviz Filter is an advanced Power BI slicer (free visual) that applies a page-level filter to the data.  Key features include:

	 •	 Hierarchy Control: support multiple hierarchies with expand / collapse and by-level formatting

	 •	 Ragged Hierarchy Support: hide BLANK category / values or both, and display child as parent
	 •	 Keep selected items at Top: enable this to show your selected items at top

	 •	 Display Mode: seamlessly switch between pop-up / canvas modes

	 •	 Default Selection: select default categories / values that automatically get filtered on refresh

	 •	 Selection Mode: single-select, multiple-select or select-all with only single-selection

	 •	 Image: add images alongside the filter.  HTML Links / Base-64 URLs Support

	 •	 Title-Bar Options: Search Bar, Clear Icon, Ranking, Filter, Sorting, Expand/Collapse.
	 •	 Conditional Formatting: highlight font and row background colour based upon specific rules
	 •	 Template: choose from professionally created light / dark templates and easily customise them using the Global styling option.

Other features included are Import / Export Themes, Interactivity, Filter Style, and more.

Business use cases include sales analysis, marketing performance tracking and financial monitoring.
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Pie of Pie by JTA

This is a Power BI custom visual that enables the creation of a hierarchical representation within a Pie chart.  With a simple click, you can delve into 
detailed categories, offering a visually intuitive way to unveil multi-level insights in a single view.

Key features include:

	 •	 interactive hierarchical representation within a Pie chart: dive into detailed categories with ease, exploring multi-level insights

	 •	 explore multi-level insights with a single click: click on a slice to reveal deeper layers of information

	 •	 customisable colours, labels, and legend: tailor the visual to match your branding or personal preferences, ensuring clarity and 		
		  consistency in your reports

	 •	 choose where to display always both pies and just show the second upon click: optimise your visual presentation by selecting the most 	
		  suitable display mode for your data storytelling needs

	 •	 animate the visual: bring your data to life with smooth animations, captivating your audience and enhancing engagement with your 	
		  insights

	 •	 personalise the spacing: fine-tune the spacing between elements to achieve greater readability in your visualisations.
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Drill Down Pie PRO by ZoomCharts

This visual can be more than just a Pie chart: it can be an interactive navigation tool for the entire report.  When the user selects a slice or drills 
down, it will cross-filter other visuals on the report, instantly revealing focused insights.  You can this create faster, more intuitive and more insightful 
reports with ZoomCharts.  Main features include:

	 •	 on-chart drill down

	 •	 cross-chart filtering

	 •	 up to nine [9] levels of hierarchy

	 •	 adjustable ‘Others’ slice

	 •	 colour, label and legend customisation

	 •	 custom ToolTip fields

	 •	 touch support.
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Hierarchical Bar chart

The Hierarchical Bar chart displays hierarchical data (different fields having parent / child relationship) in the form a bar / column chart with +/- signs 
to view / hide details or child elements.
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A new feature was added to the visual back in June whereby the users can display CAGR between the two [2] values by clicking the bars one after 
another (after turning on ‘CAGR’ in the Format pane).

This visual has the following key features:

	 •	 expand / collapse bars using (+/-) buttons

	 •	 show variance between bars

	 •	 show CAGR between bars

	 •	 drag the bars for custom sorting

	 •	 click on legends to drill down/up to any level

	 •	 show targets.

Deneb: Declarative Visualization in Power BI

Deneb is a free and open-source certified custom visual that allows developers to create their own highly bespoke data visualizations directly inside 
Power BI using the declarative JSON syntax of the Vega or Vega-Lite languages.

This is like the approaches used for creating R and Python visuals in Power BI, with the following additional benefits:

	 •	 everything in-visual: no additional dependencies on local libraries or gateways for your end-users when publishing reports
	 •	 Microsoft certified runtime: any visual you create receives the same benefits of a certified custom visual, meaning your design will work 	
		  anywhere Power BI works, including Publish to Web, mobile, PowerPoint and PDF exports

	 •	 performance: your designs are rendered directly inside Power BI rather than being delegated to another location, keeping data inside 	
		  your workbook and typically resulting in faster render times for end users

	 •	 interactivity: you can integrate Power BI’s interactivity features (ToolTips, Drillthrough, cross-filtering and cross-highlighting) with some 	
		  additional setup.
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This latest version brings many of the top requested new features to the development experience, including:

	 •	 dark mode: toggle between the traditional light theme and dark theme to reduce eye strain

	 •	 commenting: you can now add comments to your JSON for documentation and debugging purposes.

	 •	 auto-completion improvements: suggestions will now be recommended based on the details in the Vega and Vega-Lite schema

	 •	 inline language documentation (for Vega-Lite): the documentation the Vega team makes available for Vega-Lite in its language schema  
		  is now available when you hover your mouse over an appropriate location in your JSON.  This will help you discover more language 	
		  features within Deneb itself and any hyperlinks will navigate you to the correct location on the Vega-Lite documentation site for further 	
		  reading

	 •	 auto unit formatting: a new format type that applies the same logic as Power BI format numbers in K, M, Bn, etc., with less effort than 	
		  the existing Power BI value formatter

	 •	 advanced cross-filtering (for Vega): new expression functions to help generate cross-filtering of report items based on a filter against the 	
		  original dataset sent to Deneb before any transformations may have been applied.

Paginated Reports: sharing of reports connecting to Get Data data sources made easy

Microsoft has announced the ability to create paginated reports from Power BI Report Builder by connecting to over 100 data sources with the Get 
Data experience.  You no longer need to share the shareable cloud connection.  You only need to share the report and ensure that those consuming 
the report have access to view the report.  This update will be rolling out shortly.

More next month.

This month sees you able to use Copilot in Excel to unlock insights from data, work on data ranges resembling tables and prompt for step-by-step 
instructions including formula examples.  But that’s not all.  Pretty much half of our August newsletter is reproduced below!

The full list is as follows:

Excel for the web

	 •	 Copilot in Excel: unlocking insights from data

	 •	 Copilot in Excel: expanded data structure support and comprehensive answers

	 •	 Modernised Excel grid

	 •	 Synchronise Forms data to Excel

Excel for Windows

	 •	 Copilot in Excel: unlocking insights from data

	 •	 Copilot in Excel: expanded data structure support and comprehensive answers

	 •	 Checkboxes in cells

	 •	 TRANSLATE and DETECTLANGUAGE functions (Insiders)
	 •	 Python Editor (Insiders)

	 •	 Python in Excel: additional library support (Insiders)

Excel for Mac

	 •	 Copilot in Excel: unlocking insights from data

	 •	 Copilot in Excel: expanded data structure support and comprehensive answers

	 •	 Checkboxes in cells

	 •	 TRANSLATE and DETECTLANGUAGE functions (Insiders)
	 •	 Refresh data from Power Query’s ‘From Folder’ connector.

Let’s get started.

This feature is available in Excel for web, Windows and Mac.  Copilot 
in Excel keeps improving (that is a good thing since it is perhaps not as 
useful here as it is in Word and PowerPoint so far), and seeks to assist 
formatting and analysing data, and creating visualisations.

Let’s consider a very simple dataset containing US birth data from 2000 
- 2014 to learn how Copilot in Excel may help us format data, analyse 
data and create visualisations.  First, we'd like to ask Copilot to format 
our data for better readability.  In particular, we'd like to go from this: 

Copilot in Excel: unlocking insights from data

New Features for Excel
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Day of Week Births

6 9083

7 8006

to this:

A simple prompt here would be, "Convert the days of week into words.  For example, 1 is Monday.  Additionally, add thousand separators into the 
birth column".

You can go further.  Next, we should ask Copilot a question about this data.  The following prompt proves useful here: "What are the top 10 days with 
the lowest birth rate?  Give a rationale".

With this prompt, Copilot creates a table with the days with the lowest birth rate, and it provides an explanation that December 25th is a major US 
holiday, which means hospitals may have limited staff and schedule fewer elective births.

Day of Week Births

Saturday 9,083

Sunday 8,006
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To wrap up, you could ask Copilot to help create a visualisation of the data to assist in uncovering more insights.  One of the most powerful ways to 
understand data is through visualisation.  Copilot makes it easy to create compelling visuals that can highlight trends and patterns in the birth data.

Prompt: "Create a line graph that graphs the number of births by year.  Grouped by the days of the week".
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Here we see that Copilot creates a Line graph, with each line representing a day of the week.  We can see that weekdays have higher birth rates than 
weekends.

This feature is presently rolling out.
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This feature is available in Excel for web, Windows and Mac.  Users are 
no longer limited to using Copilot in Excel only in Excel Tables, because 
Copilot in Excel now works on data ranges resembling Tables with a 
single row of headers on top.  This saves time by eliminating the need to 
format data so that users may start analysing with Copilot immediately.  

In addition, the edit box is now available on any Excel worksheet, 
regardless of the selected cell.  Copilot will reason over the nearest 
table or data range resembling a table, to the user’s selected grid area 
on the same worksheet.  This enables users to interact with Copilot 

immediately, regardless of their position in the worksheet, saving time 
and increasing productivity.  

Copilot in Excel now also provides more conversational and 
comprehensive answers to a wide array of Excel-related questions.  
When prompted, users can now receive step-by-step instructions 
including formula examples or can see corrections and explanations of 
formula errors. 

All three of these features started rolling out in late July.

This feature is available in Excel for web only at this stage.  We mentioned 
this in last month’s newsletter but reproduce it here for those that 
missed the announcement.  

This update for web users provides versatile features designed to make 
your spreadsheet tasks simpler and more efficient.  Essentially Excel for 
the web is transforming from this:

Copilot in Excel: expanded data structure support and comprehensive answers

Modernised Excel grid
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to this:

You may now quickly resize rows and columns for better data visibility and presentation.  All you need to do is hover over the border of a row or 
column header, click and hold the handles, and then drag to resize.

There is also a new simplified interface which makes adding rows, or columns to your spreadsheet straightforward.  Just hover over the respective 
row or column header and then click on the small circles (convert to + on hover). 
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You may also show hidden rows or columns with one click and get a complete view of your data instantly.  Just hover over the row or column header 
and then select the small arrows that appear.

You may also keep important headers or columns visible as you scroll to ensure that important information stays visible, no matter how far you scroll 
down or across your spreadsheet.  To do so, drag the handles in the top left corner of the headers and drag them to the desired position.  To change 
existing freeze panes, just drag the freeze pane line.
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Another simplified feature is the ability to rearrange elements in your worksheet with drag and drop, making data organisation rudimentary.  To try 
the drag and drop feature, select any row or column, hold and drag when the cursor shows the hand icon, and then drop in any other row or column.
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You may also highlight important cells to emphasise critical information and improve readability.  To use this feature, just select a row, column, range 
of cells or individual cell.

Another change is that when you now hover over web or internal links, you'll see improved hyperlink previews with options to copy, edit or remove 
the link.  If a thumbnail of the linked page is available, you'll see that too, giving you a better idea of where the link will take you. 
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Customising your grid zoom is also easier now with the Status bar.  You may now quickly edit zoom values to suit your preferences by either selecting 
a percentage or typing one in.

Renaming sheets has also been updated.  Simply go to the sheet tab and double-click to rename it directly (just as you can on the desktop version): 
no more navigating through dialogs is required.

There is also a new ‘Open files from this device’ option in the File menu.  This lets you upload a local file to your OneDrive and access it directly from 
your browser. 
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Next up, Microsoft has added support for accelerator keyboard shortcuts (ALT + E, ALT + V, ALT + O) plus over 120 legacy shortcuts.  Additionally, the 
Keyboard Shortcuts dialog has been modified, with richer information and styling. 

Finally (for now!), you may now quickly access shortcuts to Feedback, Help and Keyboard shortcuts straight from the Status bar.  

These features are currently rolling out to all Excel for the web users.  I wouldn’t say they are gamechangers, but they do modernise the look and 
feel of Excel online.

This feature is available in Excel for web only presently.  Microsoft has 
been gradually rolling out Forms data synchronisation to Excel since 
early this year.  During this process, the company has actively collected 
user feedback and iterated to enhance the feature for various use cases.  
This feature is now fully available for all users, complete with additional 
capabilities. 

If you prefer to keep all your data in Excel and are used to starting your 
data collection journey there, you can now create a form directly from 
Excel for the web – no need to visit Forms.  Simply click ‘Insert’ and select 
‘Forms’ in the Ribbon.  This will open a new form in Forms where you can 
add questions.  All the questions you add and responses you receive will 
automatically synchronise with Excel.

Synchronise Forms data to Excel
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The “create from Excel” experience supports worksheets saved in OneDrive and SharePoint.  Depending upon your needs, you can choose where to 
start.  For personal forms that you want the answers accessible only to yourself, start from OneDrive.  For collaborative forms involving your team, 
start from SharePoint to ensure all team members stay updated.
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The group form data synchronisation experience has been updated to 
be smoother and more stable for greater reliability.  For forms where 
you need all team members to easily check responses, you can create a 

group form in Forms.  As new responses come in, everyone on the team 
can see them synchronise with Excel.  The Excel worksheet for the group 
form will be saved in SharePoint.

If you want your coworkers to check the new responses and do some 
further analysis, you need to share the Excel link.  When they open 
it, responses will automatically synchronise whenever responses are 

received (please note that Forms collaborators don’t have access to the 
synchronising Excel sheets from response page - you must share the 
Excel link).
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This is currently rolling out to commercial customers and expect to be fully deployed to commercial users by the time you read this.  Microsoft 
account holders should expect to see this in the near future.  

Checkboxes in cells

This feature is new to Excel for Windows and Mac.  We mentioned this feature in last month’s newsletter too.

Checkboxes are finally released to production in Excel.  These are useful for checklists (obviously!), managing tasks and visualising your data quickly.  
With just a few clicks, you can insert Checkboxes into any cell, making your spreadsheets more dynamic and user-friendly.
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To insert Checkboxes:

	 •	 select the range where you want the Checkboxes

	 •	 select Insert -> Checkbox.

To check or uncheck a Checkbox:

	 •	 click on the checkbox

	 •	 Select one or more checkboxes and press SPACE.

To remove Checkboxes:

	 •	 press the DELETE key
	 •	 if any of the Checkboxes were checked, DELETE will first uncheck them.  Press DELETE again to remove them.

These Checkboxes should be available to you all by the time you read this here!  

	 •	 Windows and Mac Desktop: rollout began June 26

	 •	 on Web and Mobile (iPad, iOS & Android): coming soon.

Microsoft expects all users on Current Channel to have access by the time this newsletter comes out

TRANSLATE & DETECTLANGUAGE functions (Insiders)

This feature is new to Excel for Windows and Mac.  Again, this was highlighted in last month’s newsletter.
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There are two new Preview functions coming to Excel.  Be careful using these: their signature and results may change substantially before being 
broadly released, based upon feedback from those fortunate enough to be able to access them.  Therefore, we strongly recommend you do not rely 
on these functions in important workbooks until they are Generally Available. 

The two new translation functions out in Preview now are TRANSLATE and DETECTLANGUAGE.

Microsoft is introducing these two new functions to simplify and automate translations directly within your spreadsheet:

	 •	 TRANSLATE(): a function that translates a text from one language to another
	 •	 DETECTLANGUAGE(): a function that detects the language of the specified text. 

TRANSLATE 

TRANSLATE takes text you provide and translates it from one language to another using Microsoft Translation Services.  Currently, there are 133 
languages supported – including two variations of Klingon!!

At the time of writing, these are:
1.	 Afrikaans	
2.	 Albanian	
3.	 Amharic	
4.	 Arabic		
5.	 Armenian		
6.	 Assamese		
7.	 Azerbaijani (Latin)	
8.	 Bangla		
9.	 Bashkir		
10.	 Basque		
11.	 Bhojpuri				  
12.	 Bodo				  
13.	 Bosnian (Latin)	
14.	 Bulgarian	
15.	 Cantonese (Traditional)		
16.	 Catalan	
17.	 Chinese (Literary)				  
18.	 Chinese Simplified	
19.	 Chinese Traditional	
20.	 chiShona			 
21.	 Croatian	
22.	 Czech	
23.	 Danish	
24.	 Dari		

25.	 Divehi		
26.	 Dogri					   
27.	 Dutch	
28.	 English	
29.	 Estonian	
30.	 Faroese		
31.	 Fijian		
32.	 Filipino			 
33.	 Finnish	
34.	 French	
35.	 French (Canada)			 
36.	 Galician			 
37.	 Georgian		
38.	 German	
39.	 Greek	
40.	 Gujarati	  
41.	 Haitian Creole	
42.	 Hausa		
43.	 Hebrew	  
44.	 Hindi	
45.	 Hmong Daw (Latin)	
46.	 Hungarian	
47.	 Icelandic	
48.	 Igbo		
49.	 Indonesian
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50.	 Inuinnaqtun	 	 	 	

51.	 Inuktitut	 	

52.	 Inuktitut (Latin)	

53.	 Irish	

54.	 Italian	

55.	 Japanese	

56.	 Kannada	

57.	 Kashmiri	 	 	 	

58.	 Kazakh	 	 	

59.	 Khmer	 	

60.	 Kinyarwanda	 	

61.	 Klingon	

62.	 Klingon (plqaD)	 	

63.	 Konkani	 	 	 	

64.	 Korean	 ko	

65.	 Kurdish (Central)	

66.	 Kurdish (Northern)	 	 	 	

67.	 Kyrgyz (Cyrillic)	 	

68.	 Lao		

69.	 Latvian	

70.	 Lithuanian	

71.	 Lingala	 	 	 	

72.	 Lower Sorbian		 	 	 	

73.	 Luganda	 	 	

74.	 Macedonian	 	

75.	 Maithili	 	 	 	

76.	 Malagasy	 	

77.	 Malay (Latin)	

78.	 Malayalam	 	

79.	 Maltese	

80.	 Maori	 	

81.	 Marathi 	 	

82.	 Mongolian (Cyrillic)	 	

83.	 Mongolian (Traditional)	 	 	 	

84.	 Myanmar	 	

85.	 Nepali	 	

86.	 Norwegian	

87.	 Nyanja	 	 	 	

88.	 Odia		

89.	 Pashto	 	

90.	 Persian	

91.	 Polish	

92.	 Portuguese (Brazil)	

93.	 Portuguese (Portugal)	 	 	

94.	 Punjabi	 	

95.	 Queretaro Otomi	

96.	 Romanian	

97.	 Rundi	 	 	 	

98.	 Russian	 	

99.	 Samoan (Latin)	 	

100.	Serbian (Cyrillic)	 	

101.	Serbian (Latin)	

102.	Sesotho	 	 	 	

103.	Sesotho sa Leboa	 	 	 	

104.	Setswana	 	 	 	

105.	Sindhi	 	

106.	Sinhala	

107.	Slovak	

108.	Slovenian	

109.	Somali (Arabic)	 	

110.	Spanish	 es	

111.	Swahili (Latin)	

112.	Swedish	

113.	Tahitian	

114.	Tamil	

115.	Tatar (Latin)	 	

116.	Telugu	 	

117.	Thai	

118.	Tibetan	 	

119.	Tigrinya	 	 	

120.	Tongan	 	

121.	Turkish	

122.	Turkmen (Latin)	 	

123.	Ukrainian	

124.	Upper Sorbian		

125.	Urdu	

126.	Uyghur (Arabic)	 	

127.	Uzbek (Latin)	

128.	Vietnamese	

129.	Welsh	

130.	Xhosa	 	

131.	Yoruba	 	

132.	Yucatec Maya	 	

133.	Zulu.	

As mentioned above, the TRANSLATE function allows you to translate text from one language to another in Microsoft Excel by using Microsoft 
Translation Services.  The full signature is: 

TRANSLATE(text, [source_language], [target_language])

This function has the following arguments:

	 •	 text: the text to translate.  This value should either be enclosed in quotation marks or be a reference to a cell containing the appropriate 	
		  text

	 •	 source_language (optional): the language code of the source language (e.g. "en" for English or "es" for Spanish).  If not specified, the 	
		  language will be automatically detected based upon the text provided.  Auto-detection is supported for most languages.  It is 		
		  recommended to specify the language if known, especially for shorter texts

	 •	 target_language (optional): the language code of the target language (e.g. "en" for English or "es" for Spanish).  If not specified, the 	
		  system language will be used as the target language.
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The supported languages and their respective language codes are as follows:

Language Language code

Afrikaans af

Albanian sq

Amharic am

Arabic ar

Armenian hy

Assamese as

Azerbaijani (Latin) az

Bangla bn

Bashkir ba

Basque eu

Bhojpuri bho

Bodo brx

Bosnian (Latin) bs

Bulgarian bg

Cantonese (Traditional) yue

Catalan ca

Chinese (Literary) lzh

Chinese Simplified zh-Hans

Chinese Traditional zh-Hant

chiShona sn

Croatian hr

Czech cs

Danish da

Dari prs

Divehi dv

Dogri doi

Dutch nl

English en

Estonian et

Faroese fo

Fijian fj

Language Language code

Filipino fil

Finnish fi

French fr

French (Canada) fr-ca

Galician gl

Georgian ka

German de

Greek el

Gujarati gu

Haitian Creole ht

Hausa ha

Hebrew he

Hindi hi

Hmong Daw (Latin) mww

Hungarian hu

Icelandic is

Igbo ig

Indonesian id

Inuinnaqtun ikt

Inuktitut iu

Inuktitut (Latin) iu-Latn

Irish ga

Italian it

Japanese ja

Kannada kn

Kashmiri ks

Kazakh kk

Khmer km

Kinyarwanda rw

Klingon tlh-Latn

Klingon (plqaD) tlh-Piqd
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Language Language code

Konkani gom

Korean ko

Kurdish (Central) ku

Kurdish (Northern) kmr

Kyrgyz (Cyrillic) ky

Lao lo

Latvian lv

Lithuanian lt

Lingala ln

Lower Sorbian dsb

Luganda lug

Macedonian mk

Maithili mai

Malagasy mg

Malay (Latin) ms

Malayalam ml

Maltese mt

Maori mi

Marathi mr

Mongolian (Cyrillic) mn-Cyrl

Mongolian (Traditional) mn-Mong

Myanmar my

Nepali ne

Norwegian nb

Nyanja nya

Odia or

Pashto ps

Persian fa

Polish pl

Portuguese (Brazil) pt

Portuguese (Portugal) pt-pt

Language Language code

Punjabi pa

Queretaro Otomi otq

Romanian ro

Rundi run

Russian ru

Samoan (Latin) sm

Serbian (Cyrillic) sr-Cyrl

Serbian (Latin) sr-Latn

Sesotho st

Sesotho sa Leboa nso

Setswana tn

Sindhi sd

Sinhala si

Slovak sk

Slovenian sl

Somali (Arabic) so

Spanish es

Swahili (Latin) sw

Swedish sv

Tahitian ty

Tamil ta

Tatar (Latin) tt

Telugu te

Thai th

Tibetan bo

Tigrinya ti

Tongan to

Turkish tr

Turkmen (Latin) tk

Ukrainian uk

Upper Sorbian hsb
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Language Language code

Urdu ur

Uyghur (Arabic) ug

Uzbek (Latin) uz

Vietnamese vi

Welsh cy

Xhosa xh

Yoruba yo

Yucatec Maya yua

Zulu zu

Suppose you have the following text in cell A1: "Hello, World!" and you want to translate it to Spanish.  You can use the TRANSLATE function as 
follows:

=TRANSLATE(A1, "en", "es")

In this example, the source language is English (en) and the target language is Spanish (es).  The translated text, "Hola mundo!" will be displayed in 
the cell where you entered the formula.

Alternatively, you may just type the text in, viz.
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Common errors include the following:

	 •	 Text Too Long: you have too many characters in a cell. Reduce your cell size and try again

	 •	 Error in Value: you have a non-text value in your cell. The function only accepts a text argument

	 •	 Invalid Language: you have entered an invalid language code or one not presently supported (see above)
	 •	 Request Throttled: you have exceeded your daily quota of the translation function (now that is interesting, but we are not quite sure  
		  what that means at the time of writing).

DETECTLANGUAGE 

DETECTLANGAUGE detects the language of text you provide using the Microsoft Translation Services and returns the language code.  The full 
signature is: 

DETECTLANGUAGE(text)

The function has the following arguments:

	 •	 text: the text or reference to cells containing text to evaluate.

The supported languages and their respective language codes are as above.

Suppose you have the following text in cell A1: "Hola mundo!" and you want to find out what the language of the text is.  You can use the 
DETECTLANGUAGE function as follows:

=DETECTLANGUAGE(A1)

This will return the detected language for the text in cell A1. The language code "es" for Spanish will be displayed in the cell where you entered the 
formula.

Alternatively, you may just type the text in, viz.



Common errors include the following:

	 •	 Text Too Long: you have too many characters in a cell. Reduce your cell size and try again

	 •	 Error in Value: you have a non-text value in your cell. The function only accepts a text argument

	 •	 Invalid Language: you have entered an invalid language code or one not presently supported (see above)
	 •	 Request Throttled: you have exceeded your daily quota of the translation function.

These functions are currently available to some Beta Channel users running:  

	 •	 Windows: Version 2407 (Build 16.0.17808.20000) or later 

	 •	 Mac: 16.87 (Build 24062430) or later.
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This feature is new to Excel for Windows.  And guess what?  This too was 
highlighted in last month’s newsletter.  What heroes we are…

Almost a year ago, Microsoft shipped a new experiment to the Excel Labs 
add-in.  This experiment allowed you to write and edit Python formulae 
in Excel using a dedicated code editor with similar capabilities as those 
available in Python notebook environments.

Now, Microsoft is making the editor available as an in-the-box option, 
and they have improved the appearance and usability of the Python 
Editor.  You’ll see a slightly different user interface that stays faithful to 
the original design, but there will be other changes shortly too.

The Python Editor enhances the Python in Excel experience by providing 
a bigger editing space for writing larger code blocks as well as productivity 
features.

From the Python Editor, you can see a list of all the Python cells in your 
spreadsheet.  Each cell is treated like that of a code cell in a Jupyter 
notebook.  Within the Python Editor pane, you can edit the cells and 
run them.  The output of the Python cell can be displayed natively in 
your Excel spreadsheet, whether it is plain text, numeric or even a 
visualisation or DataFrame.

This new Python Editor is powered by the same technology that supports 
notebooks in other Microsoft products so you can use the full range of 

editor features like IntelliSense, colourisation and function help as you 
code in Excel.

The Python Editor offers several benefits when writing and editing 
Python formulae in Excel:

	 •	 See the flow of code execution with results: the Python Editor	
		  shows Python cells in execution order in addition to the		
		  output of each cell’s code, which can help you more easily 		
		  debug and understand your code.  This is useful because, 		
		  Python in Excel cells execute in row major order

Python Editor (Insiders)
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	 •	 Easily edit longer chunks of code: the Python Editor provides a new way to create and edit your Python code, offering more immersion 	
	 	 when working with longer scripts	

	 •	 Gain flexibility with coding workflows: the Python Editor allows you to write code, click elsewhere in the application, but not commit the 	
	 	 code to Excel until you are happy with it.  This gives you more flexibility and control over when and how you apply your code to your 	
	 	 workbook.  Additionally, when in manual recalculation mode, editing and committing from the Editor will calculate just that cell (like a 	
	 	 notebook) providing a faster feedback loop	
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For the near term, there will still be two versions of the Editor, making it available wherever Python in Excel is available:

	 1.	 Built into Excel: if you are using Insiders Beta, Microsoft has now begun the rollout and you can try out the feature by going to the Ribbon  
		  and opening the ‘Editor button in the ‘Formulas’ tab

	 2.	 Excel Labs: the Python Editor will remain in Excel Labs as Microsoft ships to additional audiences.

You need to have access to Python in Excel to make use of the Python Editor.  

This feature is new to Excel for Windows.  

Python in Excel now supports additional libraries that continue to enhance data analysis and visualisation capabilities directly in Excel.  Here are the 
new libraries and their uses cases now available:

	 •	 NLTK: dive into natural language processing with the Natural Language Toolkit for text analytics and language-driven data insights.  The 	
		  following corpora are pre-loaded for use with Python in Excel: brown, punkt, stopwords, treebank, vader and wordnet2022

	 •	 TheFuzz: implement fuzzy matching to find approximate matches in your data, ideal for cleaning and preparing datasets

	 •	 Faker: generate fake data
	 •	 WordCloud: visualise word frequency in your data, making it easier to highlight key insights

	 •	 Squarify: create Treemaps to represent hierarchical data

	 •	 QRCode: generate QR codes directly within Excel
	 •	 PlotNine: create multi-layered plots that tell a story with your data

	 •	 Prince: apply principal component analysis and other dimensionality reduction techniques to simplify complex datasets

	 •	 MLExtend: extend your machine learning capabilities with additional tools for model evaluation, feature selection and ensemble methods.

Python in Excel: additional library support (Insiders)
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This feature is new to Excel for Mac.  

Microsoft has been continually adding functionality to Power Query in Excel for Mac over the past few years, such as the ability to import data from 
SQL Server databases.  People have complained that they wanted to be able to refresh data from a folder source – well now you can.

Open up an existing Excel worksheet containing a report that pulls data from a folder using Power Query.  To refresh all your reports, select Data -> 
Refresh All:

Alternatively, you may select Data -> Refresh to pull in the latest data from the folder source. 

You can change the folder source by selecting Data -> Get Data (Power Query) -> Launch Power Query Editor…. and then select the gear icon next 
to the Source option under ‘Applied steps’ and choose the folder you want.

Refresh data from Power Query’s ‘From Folder’ connector
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You can refresh your table data by simply right-clicking anywhere in the table and selecting Refresh.

This feature is rolling out to Mac Beta Channel users running Version 16.86 (Build 24051217) or later.  

Until next month.

If you have ever been involved calculating financials, you will appreciate interest is a fundamental aspect.  Annuities often need to be calculated, 
i.e. regular, periodic payments of identical amounts earning a similar rate of return.

Perhaps the easiest way to think of it is as follows:

	 •	 Let’s assume interest is set at 10% (and we will assume this is after tax)
	 •	 Something that is invested at $100 this year will increase by 10% next year, i.e. be valued at $110
	 •	 Something that is invested at $100 this year will increase by 10% over the next two years, i.e. be valued at $121
	 •	 Something that is invested at $100 this year will increase by 10% over the next three years, i.e. be valued at $133.10. etc.

Note that all of these valuations are for a point of time not a period.  This is a common mistake in modelling.  

The NPER function returns the number of periods for an investment based upon periodic, constant payments and a constant interest rate.  Its syntax 
is as follows:

NPER(rate, pmt, pv, [fv], [type])

The NPER function has the following arguments:

	 •	 rate: this is required and represents the interest rate per period.  For example, if you obtain a personal loan at a 10% annual interest rate  
		  and make monthly payments, your interest rate per month will 10% divided by 12 (number of months) or 0.83%.  You would enter  
		  10%/12, or 0.83%, or 0.0083, into the formula as the rate

The A to Z of Excel Functions: NPER
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	 •	 pmt: this too is required.  This is the payment made each period; it cannot change over the life of the annuity.  Typically, pmt contains 	
	 	 principal and interest but no other fees or taxes.  For example, if the monthly payments on a $10,000, four-year car loan at 12% are 	
	 	 $263.33 you would enter -263.33 into the formula as the pmt
	 •	 pv: this argument is also required.  This is the present value, or the lump-sum amount, that a series of future payments is worth right now

	 •	 fv: this is the first of two optional arguments.  This represents the future value or a cash balance you want to attain after the last payment 	
	 	 is made.  If fv is omitted, it is assumed to be zero [0] (the future value of a loan, for example, is zero)

	 •	 type: this is also optional.  The type should either be zero [0] or one [1] and indicates when payments are due.  If type is omitted, it is 	
	 	 assumed to be zero [0]:

For all the arguments, cash you pay out, such as deposits to savings, is 
represented by negative numbers; cash you receive, such as dividend 
receipts, is represented by positive numbers.

Sometimes, the numbers aren’t quite what you expect for this function.  
That’s because Microsoft uses the following relationship to be consistent 
across its related financial functions:

Please see our example below:

The A to Z of Excel Functions: NPV
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Three-way integrated financial statement modelling may not always be 
the end game, merely an interim marker.  Once you have created your 
model, you may wish to value it – and there are several ways this may be 
achieved.  One particular approach utilises Discounted Cash Flows and is 
known as the Net Present Value (NPV) method.

This uses the discounting approach explained in NPER (above).

Valuations include both cash inflows and cash outflows.  Adding up all 

these positive and negative present values, provides a netted off total: 
the Net Present Value (NPV).  The aim is to generate a positive return (a 
positive NPV) for a given rate of discounting, known as the discount rate.

For example, if the pre-tax cost of debt is 8% and tax is charged at 30%, 
then the post-tax cost of debt will be 8% x (1 – 30%) = 5.6%.  That’s pretty 
straightforward.  We can then calculate the blended rate known as the 
Weighted Average Cost of Capital (WACC):

Using this discount rate, we must ensure no element in the cash flow includes any reference to financing or the cost of financing, e.g.

	 •	 Debt drawdowns or repayments

	 •	 Equity issuances or buybacks

	 •	 Interest received or paid

	 •	 Dividends paid

	 •	 Tax shield on interest (i.e. the benefit of the reduced tax due to the interest deduction in the Income Statement).

Advantages

	 •	 Very common approach

	 •	 May be used for enterprise and equity valuations

	 •	 Often incorporated with probabilistic methods such as simulations analysis.

Disadvantages

	 •	 Cash flows used are often calculated incorrectly

	 •	 For typical discount rates, the terminal value (i.e. the value derived from cash flows outside of the explicit forecast period) can represent 	
	 	 	in excess of 80% of the value

	 •	 Assumes investors are rational

	 •	 Treatment of taxation and interest received is frequently misunderstood.

Assuming you have the appropriate free cash flows, consider the following simple NPV illustration:

If any of these elements were to be included, this would effectively constitute 
a double count, as the discount rate already allows for these factors.  When 
discounting using the WACC discount rate, you are evaluating the value of 
the cash flows from the perspective of all financial stakeholders.  This is 
known as the Enterprise Value and the cash flow is known as the Free Cash 
Flow to the Firm (FCFF) or the enterprise cash flow.

If instead you discounted at the cost of equity, this would be for evaluating 
what a business is worth to the equity stakeholders (i.e. the shareholders).  
This should in theory equal the market value of the share capital, or Equity 
Value.  The corresponding cash flow here is known as the Free Cash Flow 
to Equity (FCFE) or the equity cash flow.  

Finally, a lesser-known fact surrounds discounting at the cost of debt 
only.  This is used for deciding when to lease versus when to buy.  Here, 
the incremental differences in the debt financing cashflows should be 
reviewed.  If you were to assume all debt cashflows as positive (say) and 
all leasing cashflows as negative, you then evaluate this at the cost of debt 
(not the rate implicit in the lease).  If the NPV is positive, debt flows exceed 
leasing, so leasing should be chosen, and vice versa.

Enterprise valuations are used for estimating the market value of 
the business or project; equity value is used for valuing (majority) 
shareholdings.
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Here, I have assumed a multiple period NPV with no terminal value and cash flows all occurring at a point in time (e.g. Time 0, Time 1, …).  Stepping 
out the calculations, clearly the NPV at a discount rate of 8.5% equates to $8,987 in cell H30.  

Before I employ the NPV function, let’s consider its syntax:

=NPV(rate, cashflows) or 
NPV(rate, value1[, value2, …])

It should be noted that:

	 •	 rate is required.  This is the discount rate over the length of one period
	 •	 cashflows or value1, value2, ... represent the free cash flows.  The argument cashflows or value1 is required, whereas any subsequent 	
		  values are optional.  You may have one [1] to 254 arguments representing these flows

	 •	 value1, value2, ... must be equally spaced in time and occur at the end of each period

	 •	 NPV uses the order of value1, value2, ... to interpret the order of cash flows
	 •	 arguments that are empty cells, logical values or text representations of numbers, error values or text that cannot be translated into 	
		  numbers are ignored

	 •	 if an argument is an array or reference, only numbers in that array or reference are counted.  Empty cells, logical values, text or error 	
		  values in the array or reference are ignored.

The two approaches are shown below for comparison purposes:

NPV is similar to the PV (present value) function.  The primary difference 
between PV and NPV is that PV allows cash flows to begin either at the 
end or at the beginning of the period.  Unlike the variable NPV cash flow 
values, PV cash flows must be constant throughout the investment. 

Furthermore, NPV is also related to the IRR (internal rate of return) 
function.  Given the IRR is the rate for which NPV equals zero, 
NPV(IRR(cashflows), cashflows) will be zero [0].

If you use the NPV function in the example, you will note that you do not 
get the same result (see cell H33).  This is because the NPV function has 
one period’s discounting built into it.  To correct it, we have two choices:

	 1.	 multiply the result by (1 + discount_rate)
	 2.	 exclude the first period (which is undiscounted) and add it to 	
		  the result afterwards.

This is why we tend to calculate NPVs from first principles and use the NPV or XNPV functions to check our computations instead.

More Excel Functions next month.
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The A to Z of Excel Functions: NPV
The challenge this month was to replicate a Table, removing entries containing specified values using a formula in Excel.  

Filtering data in a Table in Excel is as easy as clicking the filter button 
then ticking the data you want, right?  However, if you want to see all 
but a few choice options in a field with many different entries, you may 
find yourself scrolling tirelessly to find and untick the few you don’t want 
to see.  Luckily, there are several ways to filter data based off of a list of 

values to exclude, which can be achieved using only formulae.

This month’s challenge was to write a formula to replicate data in a 
Table, removing entries as specified in a second Table.  The starting Table 
(here, imaginatively called Data) might be as follows:

The data to remove Table (named Remove) may look like this:

The result, using the inputs shown, should have looked similar to the below:

The Challenge
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As always, there were some requirements:

	 •	 the formula needed to be within just one cell (no “helper” cells)

	 •	 this was a formula challenge; no Power Query / Get & Transform or VBA

	 •	 the formula should have been dynamic enough to update when entries were added to the Remove Table
	 •	 anyone with Excel 365 should be able to use the solution.

Suggested Solution

Before we begin, let’s discuss the three functions we’ve used in conjunction to construct our solution.

The FILTER Function

FILTER is one of Excel’s Dynamic Array formulae.  It will accept an array and allow you to filter this based upon criteria you define, returning the 
results to a spilled range.

The syntax of FILTER is as follows:

=FILTER(array, include, [if_empty])

It has three arguments:

	 •	 array: this is required and represents the range that is to be filtered
	 •	 include: this is also required.  This specifies the condition(s) that must be met

	 •	 if_empty: this argument is optional.  This is what will be returned if no data meets the criterion / criteria specified in the include 		
		  argument.  It’s generally a good idea to at least use “” here.

The include argument must evaluate to an array made up of true or false and be either the same height or width as the array.

The MATCH Function

The MATCH function will return the relative position of an item in an array that (approximately) matches a specified value.

The syntax is as follows:

=MATCH(lookup_value, lookup_vector, [match_type])

It has three arguments:

	 •	 lookup_value: this is required and is the value that you want to match in lookup_array
	 •	 lookup_vector: this is required and is the range of cells being searched
	 •	 match_type: this is optional and can be either -1, 0 or 1.  This specifies how Excel matches lookup_value with values in lookup_vector.  	
		  The default argument is one [1].

The different type of match are as follows

	 •	 match_type 1 [default if omitted]: finds the largest value less than or equal to the lookup_value – but the lookup_vector must be in strict 	
		  ascending order, limiting flexibility

	 •	 match_type 0: probably the most useful setting, MATCH will find the position of the first value that matches lookup_value exactly.  The 	
		  lookup_array can have data in any order and even allows duplicates
	 •	 match_type -1: finds the smallest value greater than or equal to the lookup_value – but the lookup_vector must be in strict descending 	
		  order, again limiting flexibility.

When using MATCH, if there is no (approximate) match, #N/A is returned (this may also occur if data is not correctly sorted depending upon 
match_type).

The ISERROR Function

This function checks whether the value is an error and returns either TRUE or FALSE accordingly.

The syntax is as follows:

ISERROR(value)

It has only one argument:

	 •	 value: this is required and represents the value you want to test.
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Our Solution

Understanding those three functions, we can take a look at our solution:

=FILTER(Data,ISERROR(MATCH(Data[Item],Remove[Remove],0)),{"N/A","-","-","-"})

We have chosen to use the FILTER function on our table (named Data), keeping only values where the following argument evaluates to TRUE:

ISERROR(MATCH(Data[Item],Remove[Remove],0))

Working backwards through this argument, we first use the MATCH function (with the third argument set to zero [0], looking for an exact match) to 
attempt to match each entry in the Item field in our Data table to an entry in the Remove table.  This will return a number for each row where the 
Item field contains a value in our Remove table and an error (#N/A) for rows that do not contain one of these values.

As we wish to keep rows that do not contain values in the Remove table, we will want our errors to evaluate to TRUE and our numbers to evaluate 
to FALSE; we have achieved this using the ISERROR function.
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Finally, looking at the third argument of our FILTER function:

{"N/A","-","-","-"}

This is telling our function what to output if the filtered range is empty (i.e. no data meets the criteria / criterion), ensuring that our function will not 
result in an error even if all unique entries in the Item field are included within the Remove table.

But what if we wanted to filter out values in multiple columns?  Well, that’s one for another time…

More next month.
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

contact@sumproduct.com
www.sumproduct.com
+61 3 9020 2071

Sydney Address:	 SumProduct Pty Ltd,  Suite 803, Level 8, 276 Pitt Street, Sydney NSW 2000
New York Address:	 SumProduct Pty Ltd, 48 Wall Street, New York, NY, USA 10005
London Address:	 SumProduct Pty Ltd, Office 7, 3537 Ludgate Hill, London, EC4M 7JN, UK
Melbourne Address:	SumProduct Pty Ltd, Ground Floor, 470 St Kilda Road, Melbourne, VIC 3004
Registered Address:	SumProduct Pty Ltd, Level 14, 440 Collins Street, Melbourne, VIC 3000

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This time, we start to play Twister 
with function keys this month:

Keystroke What it does

CTRL + SHIFT + F3 Create names

CTRL + SHIFT + F4 Find previous (from most recent search)

CTRL + SHIFT + F6 Previous window / workbook

CTRL + SHIFT + F12 Print

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at http://www.sumproduct.com/
thought/keyboard-shortcuts.  Also, check out our new daily Excel Tip of the Day feature on the www.sumproduct.com homepage.

 

Location Course Course Date Local TIme UTC Duration

New York, USA Excel Tips and Tricks 24 September 2024 09:00 - 17:00 EDT
24 Sep 2024 13:00 UTC  

- 24 Sep 2024 21:00 UTC
1 Day

Sydney Australia Excel Tips and Tricks 1 October 2024 09:00 - 17:00 AEST
30 Sep 2024 23:00 UTC  

- 01 Oct 2024 07:00 UTC
1 Day

Melbourne Australia Financial Modelling
14 October 2024  

- 15 October 2024
09:00 - 17:00 AEDT

13 Oct 2024 22:00 UTC  

- 15 Oct 2024 06:00 UTC
2 Days

Philadelphia, USA Excel Tips and Tricks 15 October 2024 09:00 - 17:00 EDT
15 Oct 2024 13:00 UTC  

- 15 Oct 2024 21:00 UTC
1 Day

New York, USA Excel Tips and Tricks 24 October 2024 09:00 - 17:00 EDT
24 Oct 2024 13:00 UTC  

- 24 Oct 2024 21:00 UTC
1 Day

London UK ChatGPT
29 October 2024  

- 30 October 2024
09:00 - 17:00 GMT

29 Oct 2024 09:00 UTC  

- 30 Oct 2024 17:00 UTC
2 Days

Melbourne Australia Power Pivot, Power Query and Power BI
11 November 2024  

- 12 November 2024
09:00 - 17:00 AEDT

10 Nov 2024 22:00 UTC  

- 12 Nov 2024 06:00 UTC
2 Days
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